Note

Before using this information and the product it supports, read the information in “Notices” on page 39.
## Contents

**Chapter 1. Marketing Operations OnDemand concepts** ........................ 1
  - The Review Area ........................................ 1
  - The Schedules Area ..................................... 1
  - The Discussion Area .................................... 2
  - Libraries .................................................. 2

**Chapter 2. How to get started in Marketing Operations OnDemand** ............. 3
  - Browser requirements .................................... 3
  - Logging in to Marketing Operations OnDemand ................. 4
  - Editing your profile ..................................... 4
  - Changing your password .................................. 4
  - Entering your time ........................................ 5
  - Adding your vacation days ................................ 5
  - Getting help for Marketing Operations OnDemand ............ 6

**Chapter 3. System overview** ............................................. 7
  - Navigating Marketing Operations OnDemand .................. 8
  - Filtering and displaying items on list pages .................. 9
  - Creating a Personal Shortcut ................................ 10
  - Searching for Projects, Libraries, and Library Documents ...... 10
  - Accessing active and archived projects and libraries ......... 11
  - Selecting dates on the calendar widget ....................... 11
  - Viewing Events ........................................... 11
  - Navigating the main calendar ................................ 12

**Chapter 4. Reviews of creative content** ..................................... 15
  - The review and approval process ............................. 15
  - Filtering My Todos ......................................... 16
  - Filtering My Approvals .................................... 17
  - Responding to an approval request ............................ 18
  - Reviewing creative content in the Markup tool ............... 19

**Chapter 5. The Markup tool** ................................................ 21
  - Browser plug-in requirements for the Markup tool ............ 22
  - Issues when running the Markup tool in Internet Explorer .............................................. 23
  - Markup tool icons for all content types ...................... 24
  - Scribble toolbar icons ..................................... 25
  - Annotation List icons ...................................... 26

**Chapter 6. Project schedules and tasks** ................................... 27
  - Updating your task status .................................. 27
  - Responding to an approval task request ....................... 28
  - Filtering My Tasks .......................................... 28

**Chapter 7. Posting a note in a Discussion Area** ................................ 31
  - Archiving a Discussion Area thread ......................... 31

**Chapter 8. Libraries** ........................................................... 33
  - Working with libraries ...................................... 33

**Chapter 9. Notifications and alerts** .................................... 35
  - Sending an email notification ................................ 35
  - Defining alert settings ...................................... 36

**Chapter 10. Job Queue forms** ............................................... 37
  - Requesting marketing services with Job Queue forms ....... 37

**Notices** .............................................................................. 39
  - Trademarks ..................................................... 41
  - Privacy Policy and Terms of Use Considerations .............. 41
Chapter 1. Marketing Operations OnDemand concepts

Each project in IBM® Marketing Operations OnDemand is organized around work areas where the project team collaborates.

As a team member, you most likely will use the following work areas:

- Review Area: Review creative content on the Versions page. Manage your to-do list on the My Todos page. Manage review feedback on the Notes and Scribbles page.
- Discussion Area: Converse with project team members about specific topics or projects.
- Schedules Area: View project tasks and time lines. Report your status on assigned tasks.

In addition to these collaborative work areas, projects also include libraries. Libraries contain files that might be useful to your project work.

The Review Area

The Review Area is where teams collaboratively review and approve creative content. In a Review Area, a version is an iteration of the creative item that is being reviewed.

The Review Area includes the following pages:

- Version page: Review and approve creative content, such as videos, websites, direct mail postcards, banner ads, and print brochures. The Versions page includes an optional Markup tool for reviewing creative content. You can use the Markup tool to view, comment on, interact with, and approve versions of creative content. The Markup tool supports print, video, web, and other media files. To give feedback, team members add and reply to notes on the content.
- My Todos page: Manage the to-do items that are assigned to and created by you during the review process.
- Notes and Scribbles page: Feedback from reviews of creative content is displayed in a clickable list that includes who posted the feedback and to what version it applies. Team members can view feedback details, reply to feedback, and notify other team members about feedback. Note owners can delete, modify, reposition, and archive notes that they created. If the note is associated with a scribble, the owner can edit the note, but not the scribble.

The Schedules Area

The Schedules Area contains any schedules for the project. A project schedule contains a series of interrelated tasks, including approval tasks, that are required to complete the project. A project can have multiple schedules with different security settings for each schedule.

For each task, the schedule displays at least the following information:

- Title
- Assignee

© Copyright IBM Corp. 1996, 2014
Other information can be displayed depending on what columns you select and what information was provided by the project manager when the schedule was added to the project.

Tasks that are assigned to you are displayed with your name in bold red font. As a team member, you are responsible for updating your task status in the Progress column. Additionally, the Actions column provides options to view more details about tasks and to add notes about your status.

The Discussion Area

The Discussion Area lets team members converse about topics and work collaboratively on files.

To start a discussion, a team member posts a note about a topic in the Discussion Area and notifies others on the team. Team members can reply to the original note. A note with replies is called a discussion thread. Team members can reply to a thread until it is archived. Only project managers and the person who posted the original note can archive the note and discussion thread.

Team members can upload files into the Discussion Area for others to download and edit. The reviewers then upload their edited files for discussion. This type of collaborative review is different from what occurs in the Review Area.

- In the Discussion Area, team members change the source file that is under review, creating their own versions. Discussions are not directly related to the creative process.
- In the Review Area, team members add notes to creative content that is under review, without changing the content. The project manager maintains version control of the source file.

Typically, teams use the Discussion Area to collaborate on work. Teams use the Review Area to collaboratively review creative content while maintaining version integrity.

Libraries

Marketing Operations OnDemand includes two types of libraries for storing files. A dashboard-level (or high-level) library is available to your entire Marketing Operations OnDemand account. A project library is available for a single project and contains project-related files, such as graphic files and reference documents.

A library is a storage location; it does not support collaboration activities. Libraries can contain files and other libraries, called sub-libraries. For each file in a library, the system identifies the title, author, and expiration date. Your project manager gives you access to libraries and controls whether you can add and delete files and sub-libraries.
Chapter 2. How to get started in Marketing Operations OnDemand

A team member in Marketing Operations OnDemand is any person who collaborates on a project who does not have system administrator or project manager privileges. Some team members may be given privileges to manage work areas.

With Marketing Operations OnDemand, team members generally perform the following tasks:

- Review and approve creative content.
- Report their status on assigned tasks.
- Participate in project discussions.

Access to system tools and project work areas

Both the system administrator and project manager define what team members can do: System administrators define system access, and project managers define project access and permissions.

Your project manager controls access to project work areas. Contact your project manager if you cannot access a work area or perform certain functions in a work area.

Browser requirements

You can access Marketing Operations OnDemand using several different browsers.

Marketing Operations OnDemand supports the following browsers:

- Firefox: Download the latest version from firefox.com.
- Internet Explorer® version 9 or higher: Download the latest version from microsoft.com.

Note: IBM no longer supports version 8 for accessing Marketing Operations OnDemand.
- Safari for Mac: Download the latest version from apple.com.
- Chrome: Download the latest version from chrome.google.com.

Tip: To optimize system performance, configure your browsers for automatic upgrades.

Issue with page displays when using Internet Explorer

If you are using Microsoft Internet Explorer version 9 or 10, you may experience issues displaying the Marketing Operations OnDemand pages. This problem is caused by compatibility issues, and you need to turn on compatibility mode in your browser. The steps are different for each version of Internet Explorer, so you need to search for compatibility mode in Internet Explorer and follow the steps for your browser version.
Logging in to Marketing Operations OnDemand

When your system administrator adds you as a user to Marketing Operations OnDemand, you receive an email that describes the login process.

About this task

The email contains the URL for accessing Marketing Operations OnDemand, your user ID and password, and any custom login steps for your implementation.

Tip: Bookmark the URL and change your password the first time you log in to the system.

Important: Always log out of the system by clicking Logout in the main toolbar and not by closing the browser window.

To log in to Marketing Operations OnDemand, complete the following steps.

Procedure

2. Enter your user name and password.
3. Click Login.

Editing your profile

The main function of your user profile is to provide system security. Your profile also contains administrative settings that you can change.

About this task

You can change the following settings in your profile:

- Contact information, including email addresses, phone numbers, and postal address
- Time zone in which you work
- Your password
- Email alert settings

To edit your profile, complete the following steps.

Procedure

1. Click My Profile on the main toolbar.
2. Click Modify User.
3. Edit the fields to make the necessary changes.
4. Scroll to the bottom of the page and click Save.

Changing your password

You must change your password the first time you log in. Your system administrator defines guidelines for how often you must change your password.
About this task

Note: If you have forgotten your password, you can request to reset it from the Marketing Operations OnDemand login page. An alert will be sent to your email address. Click the link in the email alert to open the Change Password page. This link only works once. If you click the link a second time, an error message displays.

To change your password, complete the following steps:

Procedure
1. Click My Profile on the main toolbar.
2. Click Change Password.
3. Enter and confirm your password.
4. Click Save.

Entering your time

If your organization tracks time, you can record the time spent on each project. Time is tracked by either projects or categories and subcategories.

About this task

Note: If the projects you are working on are not listed, talk to your system administrator or project manager for that project.

To enter your time, complete the following steps:

Procedure
1. Click Time on the main toolbar.
2. Select the day.
3. Select the company or client.
4. Depending on how your organization tracks time, select the project and task or select the category and subcategory.
5. Select the starting and ending times.
6. Optional: Type any additional information for your entry in the Notes column.
7. Click Save.

Adding your vacation days

If your organization requires it, you can enter your vacation days. Entering your vacation days allows other users and project managers to see when you are not available for project work and reviews.

About this task

To enter your vacation days, complete the following steps:

Procedure
1. Click My Profile.
2. Select Actions > Vacation Dates.
3. Click New Vacation Date.
4. Enter a date or click the down arrow to display a calendar.
5. Enter a description.
6. Click Create.

---

**Getting help for Marketing Operations OnDemand**

IBM provides several options for getting help with your Marketing Operations OnDemand account.

**About this task**

To get help for Marketing Operations OnDemand, complete any of the following steps.

**Procedure**

- To see information about your current page, select Help > Help for this Page.
- To see a list of guides, videos, and other documentation, select Help > Product Documentation.
- To see what changes and improvements were made available in the most recent updates, select Help > What’s New.
- To contact Customer Support, select one of the following options:
  - Send an email to MKTGOPS@us.ibm.com.
  - Call 1-866-493-2673, option 4.
- To add users to the mktgops-annouce@unica.net Email Announcement List, send their email addresses to mktgops@us.ibm.com with the subject line Add Subscribers.
- To unsubscribe from the mktgops-annouce@unica.net Email Announcement List, send an email mktgops@us.ibm.com with the subject Unsubscribe.
Chapter 3. System overview

When you log in to Marketing Operations OnDemand, your homepage (called the dashboard) displays all project information that applies to you.

The dashboard contains cockpit sections that collapse and expand. A section appears only when you have relevant content for that section. For example, if you have no todos, the dashboard does not show the My Assigned Todos section.

The following table defines the cockpit section icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>Expand or collapse sections on your dashboard.</td>
</tr>
<tr>
<td>📄</td>
<td>Display additional actions for that section.</td>
</tr>
</tbody>
</table>

**Recent Postings**

The Recent Postings section displays links to new files and discussion items that are associated with your projects.

After you log in, expand the Recent Postings section and periodically refresh the section by clicking **Refresh**. Refreshing your browser window does not update this section.

**My Approval Responses**

The My Approval Responses section summarizes the number of approval responses from you that are late, due today, and due within the next week.

Clicking a link opens the My Approvals page, which is filtered for the link that you clicked. For example, if you click **Due Soon**, the My Approvals page displays only approval responses that are due within the week.

**My Managed Approvals**

If you manage Review Areas, you manage the approvals that are created in those areas. The My Managed Approvals section summarizes the number of responses for approvals that you manage that are late, due today, and due within the next week.

Clicking a link opens the My Approvals page, which is filtered for the link that you clicked. For example, if you click **Late**, the My Approvals page displays only late responses for approvals that you manage.

**My Assigned Todos**

The My Assigned Todos section summarizes the number of todos that are assigned to you that are late, due today, and due within the next week.
Clicking a link opens the My Todos page, which is filtered for the link that you clicked. For example, if you click **Due Today**, the My ToDos page displays only your todos that are due today.

**My Managed Todos**

A managed todo is any todo that was created in a Review Area that you manage. The My Managed Todos section summarizes the number of todos that you manage that are late, due today, and due within the next week.

Clicking a link opens the My ToDos page, which is filtered for the link that you clicked. For example, if you click **Late**, the My Todos page displays only todos that you manage that are late.

**My Tasks**

The My Tasks section summarizes the number of your tasks that are started, late, starting today, and due today.

Clicking a link opens the My Tasks page, which is filtered for the link that you clicked. For example, if you click **Late**, the My Tasks page displays only your late tasks.

**Account Shortcuts**

The Account Shortcuts section shows any shortcuts that your system administrator added for your account.

**Personal Shortcuts**

The Personal Shortcuts section shows the personal shortcuts that you added to the system.

**Active Projects and Libraries**

The Active Projects and Libraries section toggles between your active and archived projects and libraries.

---

**Navigating Marketing Operations OnDemand**

Marketing Operations OnDemand is a web-based system that runs in supported web browsers. Navigate the system by clicking links from your dashboard to view and modify the resources on which you work.

**About this task**

The tools menu is the horizontal menu bar, called the main toolbar, running across all system pages. The menu options that are displayed depend on your user privileges and account setup. The system administrator sets up the account and defines all user privileges.

Many pages display an **Action** menu at the top of the page or an Actions column. You can also use breadcrumbs and short cuts to navigate the system.

Click the options in the main toolbar to complete any of the following steps.
Procedure

- To record time you spend on project tasks, click **Time**.
- To record actual expenses against a budget, click **Expenses**.
- To manage top-down financial objectives and view a roll-up of financial information from projects and campaigns, click **Plans**.
- To generate and save reports, click **Reports**.
- To update your task status and to view tasks that are assigned to you across all projects, click **Tasks**.
- To manage submissions in the Job Queue, click **Job Queue**.
- To list your projects with summary information, click **Projects**. On the Projects page, you can search, filter, sort, and group the list.
- To list system libraries, click **Libraries**. On the Libraries page, you can filter, sort, and group the list to view custom fields and manage the documents.
- To manage your todos across all Review Areas, click **Todos**.
- To list all of the approvals, including approval tasks, that you manage and that are assigned to you, click **Approvals**
- To publish and view the Events lists, click **Events**.
- To view in one place all events, projects, approvals, todos, and all tasks in all schedules to which you have access, click **Calendar**.
- To update your profile, including changing your password and alert settings, click **My Profile**.

Filtering and displaying items on list pages

On pages that display lists of objects, such as the Events page, use the filter and display options to organize the lists in ways that are meaningful and helpful to you.

About this task

**Note:** On some list pages, you can also perform the following actions:

- For events, download the list of events to your calendar.
- Display the page in a printer-friendly format.
- Export the list to a .csv file.
- Select columns to display or hide.

If filter options are available for the list page, the options are shown horizontally at the top of the page. Any display options, such as **Group By** and **Sort By** are shown under the filter options. Although the specific filtering and display options might be different on every list page, how you use the options is the same.

Select the filter and display options and then click **Apply**.

Procedure

- To filter by different options, click a link and either select from a drop-down list or type text into a field.

  On the Projects, Todos, Approvals, and Job Queue pages, you can use the **Ctrl** and **Shift** keys to select multiple options from a filter.

  On the Projects page, the multi-select filter options apply to all fixed and some custom fields. The custom fields that you can use the multi-select for are dates,
radio buttons, and select lists. For example, on the Projects page, you can select all projects that have a status of **Pending** or **On Hold** for three different companies.

The following table displays the results of multi-select filter combinations that can be selected.

<table>
<thead>
<tr>
<th>One selection</th>
<th>Additional selections</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>one or more items</td>
<td>Same as selecting Any</td>
</tr>
<tr>
<td>Any</td>
<td>None</td>
<td>Same as selecting Any</td>
</tr>
<tr>
<td>None</td>
<td>one or more items</td>
<td>Same as selecting None</td>
</tr>
<tr>
<td>Any</td>
<td>None plus one or more items</td>
<td>Same as selecting Any</td>
</tr>
<tr>
<td>For Todos page only: Not complete</td>
<td>Deferred + In Progress + Pending</td>
<td>Same as selecting Not complete</td>
</tr>
</tbody>
</table>

- To group the list of items, click the Group By link and select an option from the drop-down list.
- To sort the list of items, click the Sort By link and select an option from the drop-down list.

**Note**: You can also sort the list by clicking a column name and selecting Ascending or Descending.
- To return the filter options to the default settings, click Reset next to Filters.
- To return the display options to the default settings, click Reset next to Display.

### Creating a Personal Shortcut

Create personal shortcuts on your dashboard that link to your projects, libraries, review areas, schedule areas, and discussion areas.

**About this task**

To create a personal shortcut on your dashboard, complete the following steps.

**Procedure**

1. Navigate to the page you want to bookmark.
2. Select Actions > Manage Project > Create Personal Shortcut.

**Results**

A shortcut to the page is added on your dashboard in the Personal Shortcuts section.

### Searching for Projects, Libraries, and Library Documents

You can use the search field to quickly find projects, libraries, and library documents. You can search all libraries and projects to which you have access.

**About this task**

To search for a project, library, or library document, use the Search field at the top of the screen to complete the following steps.
Procedure
1. From the drop-down list, select the type of item that you are searching for.
2. Type text that describes what you are looking for.
3. Press Enter.

Accessing active and archived projects and libraries
Your dashboard displays the active projects and libraries to which you have access. By default, active projects for all companies are displayed.

About this task
To access archived or active projects and libraries, complete any of the following steps.

Procedure
- To view projects for a specific company, select the company name from the drop-down list.
- To view archived projects and libraries, click the View Archived Projects and Libraries link. The link toggles between active and archived projects and libraries. Use the View Active Projects and Libraries link to return to a view of active entries.

Selecting dates on the calendar widget
Anywhere you need to specify a date, such as setting a start or due date, you can use the calendar widget.

About this task
The calendar widget defaults to today's date.

To select a date on the calendar widget, complete either of the following steps.

Procedure
- To change the date, click the day. Use the arrows to change months.
- To change the date back to today, click Today.

Viewing Events
Events are scheduled activities that are not necessarily related to project tasks or todos. As a team member, you can download events to your personal calendars and notify other users about the events.

About this task
Project managers define the types of events for your account and add events to the calendar.

To view events, complete the following steps.

Procedure
1. Click Events in the main toolbar.
2. Click the tab for List, Calendar, or Timeline to view the list of events in different formats.
3. On the List tab, you can select filter and display options to organize the events.
4. Click the event name to view details.
5. From the event details page, you can do the following tasks:
   - Download any attachments.
   - Send notifications to other users.
   - Download the event to your calendar.

---

**Navigating the main calendar**

The main calendar provides a snapshot of your approvals, tasks, todos, projects, and events.

**Before you begin**

Click Calendar in the Marketing Operations OnDemand toolbar.

**About this task**

You can view all approvals, tasks, approval tasks, and todos that are assigned to you, as well as the projects and events to which you have read access. The default is to display all item types in a monthly view. Item types are represented with different colors.

Use the Calendar to perform the following actions.

**Procedure**

- To view items by day, week, or month, click the corresponding option above the calendar.
- To view a date on the calendar, select or enter a date in the Go field. You can also use the right and left arrows in the upper left corner to navigate to the next or previous month, day, or week.

**Note:** The date granularity that is displayed in the Go field depends on the current view.

In the default Month view, no matter what date you enter or select, the calendar displays the entire month. In Week view, for any date you enter or select, the calendar displays the entire week. To see only a specific date, you must be in Day view.

- To filter which item types to display on the calendar, select or clear the check boxes for item types in the Calendars list.
  For example, to view only the tasks that are assigned to you, clear all of the check boxes in the Calendars list except for the Tasks check box.
  Your changes are immediately updated in both the calendar view on the right and the Items list view in the left pane.
- To view a summary of items that are scheduled for a specific date, in the Items list, click + to expand the day’s events. Click an item to display more information, including a link to the item details.
The Items list shows all items that have a start or end date in the current time period, or whose timespan includes the current time period. Only dates that contain items are listed. The items that are displayed include only the item types that you selected in the Calendars list.

- To see summary information for an item, roll over the item on the calendar. The summary includes the item status, the full path of the item (such as project name, schedule name, task name) and, if applicable, the start and end dates.

- To display more information for an item, click the item. The additional information includes a link to the item details.

Use the back button on your browser to return to the calendar.
Chapter 4. Reviews of creative content

Use the Review Area to collaboratively review creative content. The review process is started when the project manager uploads a source file for the creative content, of any file type, into the Review Area as a version. Each version of the creative content has its own Version Area where team members can discuss it and participate in the approval process.

The Markup tool provides robust collaborative review capabilities, but can be used only for certain file types.
- When the Markup tool is available to review a version, the Markup tool icon is displayed. Reviewers can comment directly on the file.
- When the Markup tool is not available, reviewers cannot comment directly on the file. However, you can add notes about the file to the Notes and Scribbles Area by using the Actions menu. You can also download the original file, add your comments to it, and attach your changed file to the note.

Versions

Each version in a Review Area is a comment-enabled file to which you can add feedback in the form of notes and scribbles. You never touch the source file for the creative content. The Markup tool converts the source file into a comment-enabled version when the file is uploaded to a Review Area. The Markup tool then collects, records, and displays all version feedback to facilitate the review process.

The project manager is responsible for uploading versions to the Review Area. After each review cycle, the project manager identifies which feedback to implement and manages this process. When a new version is ready for review, the project manager archives the previous version. The project manager then uploads a new version with a description of the changes, and the review process repeats.

Approvals

Approvals of creative items are in the form of either a single-step approval or a multiple-step approval flow that is related to a version in a review area. When a version is ready for approval, the project manager or review area manager creates a single-step approval or a multiple-step approval flow to collect approval responses from team members.

Team members cannot create approvals, they can respond only to approvals.

Note: Approval tasks are created within a project schedule to approve items outside of a Review Area. Approvals tasks are similar to a single-step approval and are displayed on your approvals list. Approvals tasks are also similar to tasks in a schedule: They can have predecessor tasks and are displayed on the Schedule page.

The review and approval process

The review process is iterative, with the project team repeating the review steps until a final version is approved.
The review and approval process for a creative item generally includes the following steps:

1. The project manager uploads a version of the creative content. Each version is in its own Version Area in the Review Area. Only project managers can create versions.
2. Team members use the Markup tool and the Notes and Scribbles Area to provide and reply to feedback.
3. The project manager determines what feedback to implement in the version and uploads the updated creative content for team members to review. The team repeats this process until the project manager creates an approval.
4. The project manager creates an approval or approval flow to collect responses from team members.
5. Reviewers receive an approval request notification or approval alert with a link to the approval.
6. Reviewers click the link to review the content and submit an approval response by selecting from the response choices: Approve, Approve with Changes, and Not Approve.

   **Note:** The options that are displayed depend on your account configuration.
7. The project manager closes the approval.
8. The approval or approval flow is closed either automatically or manually by the project manager.

---

**Filtering My Todos**

Todos are action items that are created and assigned during the review process. The My Todos page includes an assignment filter and a due date filter.

**About this task**

**Note:** While todos are part of the review process, tasks are action items that are part of a project schedule.

Select the display options and then click **Apply**. Use the **Ctrl** and **Shift** keys to select multiple options from a filter.

**Note:** You cannot select multiple options for the assignment or archive filters.

**Procedure**

- To filter by company, select one or more company names or either of the following options:
  - **Any company**
  - [No company]
- To filter by assignment, select one of the following options:
  - Assigned to you
  - Managed by you
  - Managed by and assigned to you
  - Assigned to any user
- To filter by status, select from the following options:
  - Any status
  - Not complete
What to do next

When you have finished your todo, mark it as Complete.

Filtering My Approvals

The My Approvals page shows information about all approvals to which you have access.

About this task

You can filter the approvals by company, assignment, approval status, archive status, due date, and approver response. Select the filter options and then click Apply. Use the Ctrl and Shift keys to select multiple options from a filter.

Note: You cannot select multiple options for the parent, assignment, and archive filters.

Procedure

- To filter by company, select one or more company names or either of the following options:
  - Any company
  - [No company]
- To filter by type of approval, select the parent:
  - Review Area
  - Schedule
- To filter by assignment, select one of the following options:
  - Assigned to you
  - Managed by you
  - Managed by and assigned to you
  - Assigned to any user
- To filter by approval status, select from the following options:
  - Any
  - Closed, Approved
  - Closed, Canceled
  - Closed, Not approved
  - Open
  - Not started
- Filter by archived or active approvals.
To filter by due date, select from the following options:
- Due Anytime
- Due in the Past
- Due Today
- Due Soon

To filter by approval response code, select from the following options:
- Response Code: Any
- Response Code: Approved
- Response Code: Approved with Changes
- Response Code: Not Approved
- Response Code: None

Responding to an approval request

During the review and approval process, the project manager creates an approval or approval flow to collect responses from team members. Reviewers receive an approval request notification or approval alert with a link to the approval.

About this task

To respond to an approval request, complete the following steps.

Procedure

1. Open the approval request notice and click the link to go to the version. You can also access the version from the My Approval Responses section on your dashboard or from the My Approvals page.
2. Review the version.
3. If the version is not locked, you can start the Markup tool to add your comments.

   Note: If the version is locked in the approval, you cannot use the Markup tool to make comments. If your administrator enabled the "Approved with changes" response option, you can enter your comments there.

4. In the Respond to Approval window, select the appropriate option from the Response drop-down list and click Respond.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>Approve the version as is. You can enter comments if the comments field is available, as configured by your system administrator.</td>
</tr>
<tr>
<td>Not approved</td>
<td>Do not approve the version as is. You can enter comments if the comments field is available, as configured by your system administrator.</td>
</tr>
<tr>
<td>Approved with changes</td>
<td>Add your comments to approve the version with the specified changes. Note: The &quot;Approved with changes&quot; option is available only if the system administrator configured the setting in the account.</td>
</tr>
</tbody>
</table>
Reviewing creative content in the Markup tool

When the creative content is of a file type that is supported by the Markup tool, use the tool to review the item.

About this task

To review content in the Markup tool, complete the following steps.

Procedure

1. Start the Markup tool.
   - If you receive an email notification about a version to review, click the link to view the version in markup mode. If you are logged in, the Markup tool starts automatically. Otherwise, you must log in to start the Markup tool.
   - If you are in the Review Area, click the link for the version to be reviewed.
   - If you are on the Versions page, click the Markup tool icon or select the Markup tool in the Action column.
2. Use the toolbar menu options and the Annotation List icons to add notes and scribbles that request changes or to reply to notes already posted.
3. Exit the Markup tool when you are done.

Important: To ensure that the Markup tool exits properly, do not close the browser window. Always click the exit icon.
Chapter 5. The Markup tool

The Markup tool allows you to collaborate with project team members to edit creative content. The Markup tool runs in its own browser window. You can add your feedback as notes or scribbles directly on a version for others to see. You can send an email notification to team members with a link to your note or scribble.

The Markup tool provides multimedia support so team members can run video and flash-based files within the Markup tool. They can insert notes at specific time points.

**Note:** Your browser must support the appropriate plug-ins to review multimedia content in the Markup tool.

The Markup tool collects all feedback in a clickable list. Team members can scan the list to see who posted the feedback and on what versions. They can also view the feedback details, reply to feedback, and notify other team members about feedback.

When the Markup tool is enabled for reviewing a version, the Markup tool icon appears in the Markup Enabled column. Team members click the link to view and reply to comments.

The Markup tool review capabilities depend on the type of content. Different icons, to the left of the version link, indicate the type of content.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Print media icon" /></td>
<td>Print media</td>
</tr>
<tr>
<td><img src="image" alt="Web media icon" /></td>
<td>Web media</td>
</tr>
<tr>
<td><img src="image" alt="Multimedia icon" /></td>
<td>Multimedia</td>
</tr>
</tbody>
</table>

The Markup tool includes the following components:
- The Markup toolbar
- The Scribble toolbar
- The Content pane
- The Navigation pane (for print content only)
- The Annotation List pane

**The Markup toolbar**

The menu options that are displayed on Markup toolbar depend on whether you are reviewing print, web, or multimedia content.

**The Scribble toolbar**

The Scribble toolbar is available for print and web content.
When you are done scribbling, you can enter a comment in the Add a Scribble window. You can enter only one comment per set of scribbles.

**Tip:** Use a single color for each set of scribbles to visually group them for easier interpretation by other reviewers.

**The Content Pane**

The Content Pane displays the creative content that is being reviewed. It is where team members post and reply to feedback by using either the toolbar menu options or the Annotation List.

When you review print content, you can drag content into the Content Pane. You also can zoom in and zoom out on print content within the Content Pane.

**The Navigation Pane**

The Navigation Pane is available only for print content. Click the thumbnails to display the pages of the creative content in the Content Pane.

The Navigation Pane does not display in the Markup tool for multimedia content. Use the arrows to display different frames in multimedia content.

**The Annotation List**

The Annotation List lists all reviewer feedback. You can sort the list by any of the following options:
- Feedback type
- Feedback date
- Feedback author
- Feedback subject
- Feedback source

From this pane, you can perform the following actions:
- Modify a todo or annotation note
- Delete a todo or annotation note
- Send an email notification
- Reply to the annotation note

**Note:** If you are the manager of the Review Area, you can modify and delete any notes. Otherwise, you can modify and delete only notes that you added.

**Browser plug-in requirements for the Markup tool**

Most browsers require plug-ins to run video and audio files.
Your browser must support the following plug-ins to use the Markup tool to review multimedia content.

<table>
<thead>
<tr>
<th>Browser plug-in</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>QuickTime 7 or higher</td>
<td>.qt</td>
</tr>
<tr>
<td></td>
<td>.mov</td>
</tr>
<tr>
<td></td>
<td>.mpg</td>
</tr>
<tr>
<td></td>
<td>.mpeg</td>
</tr>
<tr>
<td></td>
<td>.mp3</td>
</tr>
<tr>
<td>Flash 8 or higher</td>
<td>.swf</td>
</tr>
</tbody>
</table>

**Issues when running the Markup tool in Internet Explorer**

If you are using Microsoft Internet Explorer, you must use version 9 or higher to run the Markup tool.

Internet Explorer opens the Markup tool in a new browser window by default. You can configure the browser to open the Markup tool in a new browser tab.

*Note:* Working with QuickTime videos (.mov files) in the Markup tool is not supported in Internet Explorer version 9 (64-bit) in the Windows 7 operating system. You will need to run the Internet Explorer version 9 (32-bit).

**Security warnings when you review web content**

The Markup tool is a secure web application that uses an https connection. If the web content that you are reviewing is on a non-secure site (the URL starts with http), Internet Explorer displays a non-secure content prompt. When the message is displayed, select **No** to display all web content. You can also disable the message in Internet Explorer.

If you are using Internet Explorer 9 or higher, you might not see a warning, but the web page does not display. If this happens, select the option to display mixed content.

**Problems seeing web content in the Markup tool**

Problems seeing web content in the Markup tool can be the result of any of the following circumstances:

- Connection issue with the system
- Frames in the web page: The Markup tool does not support frames.
- Missing browser plug-in
- Invalid URL for the version: The following message is displayed:
  
  Internet Explorer cannot display the web page

To verify the URL, complete the following steps:

1. Right-click the error message.
2. Select **Properties** from the pop-up menu.
3. Select the option to enable mixed content.
4. Copy and paste the URL into another browser window.
One of the following results occurs:

- If the page does not open, the URL is invalid or you have an Internet connection problem.
- If the page opens, the URL is valid. Report the Markup tool problem to your system administrator.

**Markup tool icons for all content types**

The Markup tool for print, web, and multimedia content displays several icons. You can place your cursor over an icon to see a brief description.

The following table defines the icons that are used in the Markup tool:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Content type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Multimedia</td>
<td>Play the multimedia content.</td>
</tr>
</tbody>
</table>
| ![Icon](image2) | Multimedia | Move through the multimedia content.  
- ![Icon](image3) Go to the beginning.  
- ![Icon](image4) Go backward 5 seconds.  
- ![Icon](image5) Go backward one frame.  
- ![Icon](image6) Go forward one frame.  
- ![Icon](image7) Go forward 5 seconds. |
| ![Icon](image8) | Multimedia | Change the size of the multimedia window in the Content pane. |
| ![Icon](image9) | Print and web | Scribble in the Content pane. You can draw free-form scribbles, straight lines, rectangles, ellipses, and arrows in various colors and transparency.  
When you are done, click **Click HERE when you are finished scribbling**. Type comments in the Add a Scribble screen. |
| ![Icon](image10) | Print and web  
- Print and web  
- Multimedia | Drag a Note to the Content pane. Enter comments in the Add a Note screen.  
For multimedia, the Markup tool stores your note at the point where you added it in the content.  
You can modify, delete, archive, and move notes that you created. You can delete and archive notes that others created if you have permissions to do so. Team members can also reply to notes and send notifications about notes. |
| ![Icon](image11) | Print and web  
- Print and web  
- Multimedia | Add a todo and assign it to a team member. |
| ![Icon](image12) | Print | Zoom in on the Content pane. |
The Scribble toolbar icons

The Scribble toolbar displays several icons. You can place your cursor over an icon to see a brief description.

The following table defines the icons that are used in the Scribble toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Content type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>📲</td>
<td>Print</td>
<td>Zoom out of the Content pane.</td>
</tr>
<tr>
<td>📲</td>
<td>Print</td>
<td>Return the default zoom setting in the Content pane.</td>
</tr>
<tr>
<td>🌐</td>
<td>Web</td>
<td>Open the URL for the web content you are reviewing. The web page opens in a new browser window.</td>
</tr>
<tr>
<td>📧</td>
<td>Print and web Multimedia</td>
<td>Send an email notification about the version.</td>
</tr>
<tr>
<td>📜</td>
<td>Print Multimedia</td>
<td>Download the version source file.</td>
</tr>
<tr>
<td>📜</td>
<td>Print Multimedia</td>
<td>Manage an approval for this version.</td>
</tr>
<tr>
<td>📜</td>
<td>Print and web Multimedia</td>
<td>Manage an approval for this version.</td>
</tr>
<tr>
<td>📜</td>
<td>Print and web</td>
<td>Show the Navigation pane.</td>
</tr>
<tr>
<td>📜</td>
<td>Print and web</td>
<td>Show or hide the Annotations List pane.</td>
</tr>
<tr>
<td>📜</td>
<td>Print and web</td>
<td>Open the online help.</td>
</tr>
<tr>
<td>🌟</td>
<td>Print and web Multimedia</td>
<td>Exit the Markup tool. <strong>Important:</strong> Do not close the browser window to exit the Markup tool.</td>
</tr>
<tr>
<td>Icon</td>
<td>Function</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Draw an ellipse with no fill.</td>
<td></td>
</tr>
<tr>
<td>■</td>
<td>Draw a filled rectangle.</td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>Draw a filled ellipse.</td>
<td></td>
</tr>
<tr>
<td>▼</td>
<td>Choose a color for your scribble, line, rectangle, or ellipse. Selecting a color affects all created scribbles until a different color is selected. You can change the degree of transparency by using the slider bar below the color palette. Use the text preview to see how the color and transparency settings appear. You can highlight an area while still seeing the underlying content.</td>
<td></td>
</tr>
<tr>
<td>⇐</td>
<td>Undo the last scribble. You can repeat this command to undo multiple scribbles.</td>
<td></td>
</tr>
<tr>
<td>➔</td>
<td>Redo the last removed scribble. You can repeat this command to revert some or all removed scribbles.</td>
<td></td>
</tr>
</tbody>
</table>

### Annotation List icons

The Annotation List displays several icons. You can place your cursor over an icon to see a brief description.

The following table defines the icons that are used in the Markup tool Annotation List.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✍</td>
<td>Modify the todo or note only if you created the note.</td>
</tr>
<tr>
<td>✗</td>
<td>Delete the todo or note.</td>
</tr>
<tr>
<td>💌</td>
<td>Send an email notification about the todo or note.</td>
</tr>
<tr>
<td>➔</td>
<td>Reply to the note.</td>
</tr>
</tbody>
</table>
Chapter 6. Project schedules and tasks

A schedule is a set of tasks to be completed in a project. Project managers create schedules to organize all of the work that needs to be done for the project.

Schedules can include tasks and approval tasks, which are single-step approvals. Tasks can be as simple or as detailed as is needed for the project. Each task in a schedule can be assigned to a member of the project.

Note: Tasks are action items that are created and assigned as part of a project schedule. Todos are action items that are created and assigned during the review process.

As a project team member, you might be assigned tasks in several project schedules. The My Tasks page displays a list of tasks that are assigned to or managed by you across all of your projects.

You can monitor your tasks and approval tasks across projects on your dashboard. You can update your task status from the My Tasks page. The Project Schedule displays both tasks and approval tasks, and you can update both types of tasks.

Updating your task status

From the My Tasks page, you can update your task status and record your task time across projects.

About this task

Note: You can view and update your approval tasks on the My Approvals page. "Responding to an approval task request" on page 28 describes how to update an approval task.

Complete the following steps on the My Tasks page or Project Schedule to update your task status.

Procedure

1. Select the task that you want to update by selecting the cell in the Progress column or by selecting the check box.
2. Select the percentage complete.
   
   You can close multiple tasks by selecting Perform an Action > Mark Tasks Complete and clicking Update.
3. Click Notes in the Actions column to provide information to your project manager about the task.
4. Click Update to record your task status and update the relevant project schedules.
5. If time tracking is enabled, you can add your time entry for this task by clicking the Time icon.
Responding to an approval task request

Approval tasks are displayed on both the My Approvals page and the Project Schedule page. If your approval is required for an approval task, you will receive an Approval Request Notice email message.

About this task

To respond to an approval task request, complete the following steps.

Procedure

1. Open the Approval Request Notice and click the link to open the approval task. You can also open the approval task from the My Approvals page or Project Schedule page.
2. Review the information in the approval task.
3. Select the appropriate option from the Response drop-down list, or use the Actions menu to either approve or reject the item. You cannot change the status of approval tasks in the following conditions:
   - Approvals that are closed
   - Approvals to which you have already responded
   - Approvals to which you have access but do not manage
4. Click Respond.

Filtering My Tasks

The My Tasks page displays tasks that are assigned to you or managed by you across all projects. You can filter the tasks to help you manage them.

About this task

You can filter the tasks list to show any of the following tasks. Select the display options and then click Apply.

Procedure

- Tasks for a specific company
- Tasks that are assigned to you or managed by you
- Tasks with any of the following states:
  - Open
  - Complete
  - Unbalanced - Closed tasks with remaining time or open tasks with no remaining time
  - Good To Go - In predecessor-based schedules, tasks that are ready to be started
  - Any
  - Started
  - Late
  - Starting today
  - Starting within 7 days
  - Starting within 30 days
  - Due today
- Due within 7 days
- Due within 30 days
- Tasks that are active or archived
Chapter 7. Posting a note in a Discussion Area

Any project team member can start or reply to a discussion topic in a Discussion Area.

About this task

To add a note or reply to a note in a Discussion Area, complete the following steps.

Procedure

1. Do one of the following actions:
   • To start a discussion thread, in the Discussion Area, click New Note in the menu bar.
   • To reply to a discussion, click the note and then click Reply to this.
2. On the New Note page, type a subject.
3. Type your message.
4. Optional: Browse to select a file to attach to the note. You can attach multiple files to a note.
5. Optional: Select Notification to send an email notification to team members about your note.
6. Click Post.

Archiving a Discussion Area thread

Project managers can archive any discussion threads in Discussion Areas that they manage. Team members can archive only discussion threads that they started.

About this task

To archive a discussion thread, complete the following steps.

Procedure

1. Click the first post in the Discussion Area thread that you want to archive.
2. Click Archive.
Chapter 8. Libraries

There are two types of libraries in Marketing Operations OnDemand. A project library is a place to store files that are associated with a project. A top-level library stores files that are not specific to a particular project, such as logos or branding guidelines.

You cannot collaborate within a library. A library is strictly a storage location for items such as graphic files, reference documents, and market research. You can think of a library as a folder or directory because a library can contain files or other libraries.

Both types of libraries can be accessed from the Library link on the main toolbar.

Project managers control the security of project libraries. They can make libraries available only to project members and limit which project members can view specific project libraries. For example, you can have market research documents in a library available to internal project members only. This configuration prevents the external design agency and web programmers in your project from accessing these documents.

Working with libraries

A library is either active or archived. You can access archived libraries, but you cannot add or delete files or sub-libraries in archived libraries.

About this task

To work with libraries, complete any of the following steps.

Procedure

- To download a file from a library, complete either of the following actions:
  - On the Libraries list page, click the link in the Title column to display details about the document. Then, click the link to the document or right-click the link and save the file to your computer.
  - On the Libraries list page, click the link in the File Name/URL column or right-click the link and save the file to your computer.
- To open a sub-library, click the library name from the Libraries list page.
- To add a sub-library, click New Library from the Libraries list page. Complete the fields and click Create.
- To post a file to the library, click New Document from the Libraries list page. Complete the fields, select a file to upload, and click Create.
- To sort library content, use the arrows in the column headers. The system applies your last sort order to any library you visit.
- To send library documents to someone outside of the project or outside of Marketing Operations OnDemand, click Forward on the Library details page.

Note: You cannot forward files larger than 1 MB.
Chapter 9. Notifications and alerts

Email notifications are a quick way to notify team members about your project-related activities. You control when and to whom your email notifications are sent. Email alerts are messages that the system emails to you automatically based on settings in your profile.

Important: Marketing Operations OnDemand sends all alerts and notifications from a single designated "Postmaster" email address that is set up for your account. To ensure that you receive email alerts and notifications, add the email address of your Postmaster to the Safe Sender list of your email client. In most cases, the Postmaster address is noreply@bhtu.com. Contact your system administrator to determine your Postmaster address.

Notifications

When you work in a project work area, you can send email messages to team members to describe what you did and include a link to your work. You do not need to use your email client. Instead, the system generates and sends the email for you.

You select the team members to notify from a list of team members and user groups with access to the work area in which you are working. The system inserts the email addresses that are specified in member profiles.

Because team members control when to send email notifications to each other, you cannot turn on or off notifications as you can for alerts. If email notifications become a burden, contact your project manager who can advise team members on their use.

Alerts

There are three types of alerts:

• Schedule alerts
• Library document alerts
• Approval alerts

You can turn alerts on and off in your profile. You can also define the following options:

• When the system sends you alerts (number of days before or after an event)
• What types of alerts the system sends
• Where the system sends your alerts (primary and urgent email addresses)

Sending an email notification

You can send an email notification to team members to inform them of your project-related activities.

About this task

To send an email notification, complete the following steps.
**Procedure**

1. Depending on the page, click the **Notification** option or click **Notify** in the menu bar.
2. Select the team members to receive the email notification.
3. Optional: Specify whether the notification is urgent.
4. Optional: To blind copy any recipients, select **BCC** and select the recipients.
5. Optional: Specify whether you want a copy of the message sent to your email address.
6. Optional: Edit the subject.
7. Optional: Edit the message text.

**Important:** Do not edit the link.
8. Click **Send**.

---

**Defining alert settings**

You can specify which alerts you receive and whether they are sent to your standard email address or your urgent address. You can also specify when time-dependent alerts are sent to you.

**About this task**

To define your alert settings, complete the following steps.

**Procedure**

1. Click **My Profile** on the main toolbar.
2. Click **Modify User**.
3. Edit the fields in the Email Alert Settings section.

**Note:** The fields are defined on the profile page.
4. Click **Update**.
Chapter 10. Job Queue forms

Marketing Operations OnDemand provides the Job Queue feature for integrated request management services. Using Job Queue forms, you can request marketing services such as projects and events, even if you do not have a login to Marketing Operations OnDemand.

Types of Job Queue forms

There are three types of Job Queue forms:
- Project forms
- Event forms
- Email only forms: For general requests, such as a request for a photograph or logo

User roles

There are three types of users in the Job Queue feature:
- Marketing Operations OnDemand system administrators create the job queue forms.
- Requesters complete the forms to request marketing services.
- Job queue administrators review the completed forms to determine whether the request should be fulfilled.

Job Queue form states

A completed job queue form can be in any of the following states:
- Draft: You save a form without submitting it, or a job queue administrator returns the form to you for more information.
- Pending: You submit a project or event form.
- Denied: A job queue administrator rejects a request. A job queue administrator can reject pending requests only. You cannot edit or resubmit a denied request.
- Fulfilled: You submit an email only form, or a job queue administrator fulfills a pending project or event form.

All requests from project forms and event forms enter the job queue as pending requests. Because email only forms do not create anything in the system, they enter the job queue as fulfilled requests.

Requesting marketing services with Job Queue forms

You complete Job Queue forms to provide information about your marketing service requests.

About this task

Note: You can create a request from an existing Job Queue form. Click Copy on the bottom of a draft or submitted Job Queue form. The copy is in draft status and contains all field values from the original request form, which you can edit.
To complete a Job Queue form, complete the following steps:

**Procedure**

1. Use the link that is provided by the system administrator to open the Job Queue form.
2. Complete the Job Queue Form. Hover help provides information about each field.
3. To receive notifications about this form, select the option for notifications and enter your email address. The system sends notifications whenever the request status changes.
4. Do either of the following steps:
   - Click **Save Draft**. The information that you entered is saved, and you can return to it later.
     
     **Tip:** Bookmark the page so you can find it more easily.
     When you save a draft, you must enter your email address to receive the URL by email. All other fields are optional. Anyone with the draft form URL can access and modify the form.
   - Click **Submit** to complete the request.
     All required fields must be completed for a successful submission. Errors in the submission are identified with red text.

**What to do next**

You can complete any of the following steps:

- Withdraw the request by clicking **Withdraw** in a submitted request.
- Rework the request if the job queue administrator returns the request. Then, resubmit.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information about the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

---

**Trademarks**

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

---

**Privacy Policy and Terms of Use Considerations**

IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. A cookie is a piece of data that a web site can send to your browser, which may then be stored on your computer as a tag that identifies your computer. In many cases, no personal information is collected by these cookies. If a Software Offering you are using enables you to collect personal information through cookies and similar technologies, we inform you about the specifics below.

Depending upon the configurations deployed, this Software Offering may use session and persistent cookies that collect each user's user name, and other personal information for purposes of session management, enhanced user usability, or other usage tracking or functional purposes. These cookies can be disabled, but disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through cookies and similar technologies. If the configurations deployed for this Software Offering provide you as customer the ability to collect personal information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer’s website terms of use (e.g. privacy policy) which includes a link to IBM’s and Client’s data collection and use practices, (2) notify that cookies and clear gifs/web beacons are being placed on the visitor’s computer by IBM on the Client’s behalf along with an explanation of the purpose of such technology, and (3) to the extent required by law, obtain consent from website visitors prior to the placement of cookies and clear gifs/web beacons placed by Client or IBM on Client’s behalf on website visitor’s devices.

For more information about the use of various technologies, including cookies, for these purposes, See IBM’s Online Privacy Statement at: http://www.ibm.com/privacy/details/us/en section entitled "Cookies, Web Beacons and Other Technologies."